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Screen Capture Help Contents
To learn how to use help, press F1.

Using Screen Capture
A complete guide to Screen Capture with step-by-step instructions

Reference Information
Thorough explanations of Screen Capture components

 Programming with ImagePals
Information about the Ulead ADK and how to order it

Product Support
How to contact Ulead Systems if you have questions

Other ImagePals Program Helps
Quick access to on-line help for all the other ImagePals programs



Reference Information
How to Use This Help

Menu Commands
Screen Capture Ribbon
Status Bar
Shortcuts
Tips & Techniques
Glossary



Menu Commands
File Menu
Edit Menu
Capture Menu
Convert Menu
View Menu
Window Menu
Help Menu
Switch Menu

Related topic
Window Control Menu



    File Menu

Open
Close
Save

Save As

Batch Manager

Print
Printer Setup
Preferences
Settings
Exit
Recent Files List



    Preferences Submenu
Contains commands to customize several features of Screen Capture.

Screen Capture

Photo CD

Display

Memory

File Formats



    Settings Submenu
Contains commands to load and save program settings to a file.

Load

Save



    Edit Menu
Undo
Cut
Copy
Clear
Select All
Select None

Crop

Expand

Resolution

Color Schemes

Background Color



    Capture Menu
Source
Destination
Pointer

Activation

Post Processing
Note: You can also specify these capture settings in the Screen Capture Ribbon.

Related topic
Screen Capture Ribbon



    Source Submenu
Allows you to specify the source from which you can capture images.

Active Window
Active Workspace
Full Screen
Menu Under Pointer
Selected Object
Selected Area
Clipboard

Execution File
Note: You can also specify the source from the Ribbon's source list box. 

Related topic
Screen Capture Ribbon



    Destination Submenu
Allows to specify where captured images will be placed.

File
Workspace
Clipboard

Printer
Image Editor

Note: You can also specify the destination(s) in the Ribbon.

Related topic
Screen Capture Ribbon



    Pointer Submenu
Allows you to choose the pointer (if any) to capture with the captured image.

No Pointer
Arrow    

Hourglass    

Crosshair    

Text I-beam    

User Defined



    Convert Menu

Black & White

Grayscale
Indexed 16-Color
Indexed 256-Color

RGB HiColor

RGB True Color

Related topic
Converting images



    Converting to Indexed 16-Color

When you convert to Indexed 16-Color, depending on the data type of the active image, Screen 
Capture provides different options:

From Black & White

From Grayscale

From Other Color Data Types



    Converting to Indexed 256-Color

When you convert to Indexed 256-Color, depending on the data type of the active image, Screen 
Capture provides different options:

From Black & White

From RGB True Color or HiColor



    View Menu
Actual View
Zoom In
Zoom Out
Fit in Window
Image Information
System Information

Color Table

Hide/Show Ribbon

Hide/Show Status Bar



    Window Menu
Cascade
Tile
Arrange Icons
Windows List



    Help Menu
Contents
Search for Help On
How to Use Help
About Ulead Products
About Screen Capture



    Switch Menu

This menu lists the other ImagePals programs. Click on a name and the corresponding program is 
invoked. You can also access the Windows Program Manager,File Manager and Clipboard Viewer (if 
available).



    Windows Control Menu

Every window has its own control menu in the top left corner to manage the window itself. Some control
menus also contain an additional command such as Next or Run. These commands allow you to swap 
between windows.

Restore restores a window to its normal size (i.e. the size it was before being maximized or 
minimized)

Move allows you to move the window
Size allows you to change the size of the window
Minimize reduces the window to an icon
Maximize enlarges the window to fill all available space (either on screen or within a parent 

window)
Close closes the window
Switch To brings up the Windows Task List dialog box



Shortcuts
Screen Capture has many keyboard shortcuts and mouse actions that save you time and 
trouble when capturing images. This section lists all the shortcuts. You may want to print this
topic if you wish to keep a copy for reference.

Click here to print this topic
Click here to close this window

File Menu
Ctrl + O Displays the Open dialog box
Ctrl + S Saves the active image file
Ctrl + P Displays the Print dialog box
Ctrl + Q Exits Screen Capture

Edit Menu
Ctrl + Z Undoes the last command
Ctrl + X Cuts a selection onto the clipboard
Ctrl + C Copies a selection onto the clipboard
Del Replaces the selection with background color
Ctrl + L Selects the whole image
Ctrl + N Deselects a selection
Ctrl + R Crops the edges of the selection area
Ctrl + E Displays the Expand dialog box
Ctrl + U Displays the Resolution dialog box

Capture Menu
Ctrl + W Sets capture source to Active Window
Ctrl + F Sets capture source to Full Screen

View Menu
Ctrl + A Shows the actual view of the image
+ Zooms in on the active image
- Zooms out on the active image

Window Menu
Shift + F5 Cascades all image windows
Shift + F4 Tiles all image windows

Help Menu
F1 Opens Screen Capture Help
Shift + F10 Opens Windows Help

Miscellaneous
Esc Closes the dialog box without any changes

Mouse Actions
Click right mouse button Deselects a selection
Double-click title bar Maximizes or restores the active window
Double-click workspace Displays the Batch Manager dialog box
Double-click status bar Displays the Screen Capture dialog box
Double-click ribbon Hides the Screen Capture ribbon





 Other ImagePals Program Helps

Album

Image Editor

Viewer

CD Browser



Open
File Name shows the selected file extension or filename; enter the filename you wish to open or 

select a filename from the list box below
List Files of Type lists the file extensions of image and graphic files that Screen Capture can 

open
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Options accesses the open options dialog boxes for file formats that provide options
Browse accesses the Browse dialog box, use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups.)
Preview Button displays the thumbnail of the selected file with some information

Related topic
Opening an image



Save As
File Name allows you to enter a filename or, if you wish to overwrite an existing file, select its 

filename from the files list box
List Files of Type shows the available file formats and their extensions
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Options accesses the save options dialog boxes for file formats that provide options. This button 

is only available for some file formats.
Browse accesses the Browse dialog box; use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)
Save to Album allows you to choose whether or not to save a thumbnail of the file to Album
Album opens the Insert Thumbnails into Album dialog box. Use this to place files into albums in 

Album's workspace or into a newly created album

Related topic
Saving an image



Batch Manager
Operation lists all the commands that can be applied to multiple images
Images displays the filenames of images in the workspace
Select All selects all the images in the workspace
Deselect deselects any selected images

Note: Double-clicking anywhere in the workspace displays the Batch Manager dialog box.

Related topics
Using the Batch Manager
Converting images
Convert dialog box
Resolution dialog box
Expand dialog box



Screen Capture
Hide When Capturing hides the Screen Capture window when capturing
Crop When Menu Under Pointer affects images captured when current source is Menu under 

Pointer
Enable Undo enables the Undo command in the Edit menu
Number of File Names Kept specifies the number of files, which can be opened directly, listed at

the bottom of the File menu



Display
View Images With a Common Palette displays all images on a 256-Color display using the 

system palette
Don't Care About Background Quality causes only the active image to be displayed as well as 

possible
Monitor Gamma allows you to adjust the display of images to accommodate for differences in 

working environments
VGA Palette enables you to adjust the display of images on 16-Color displays



VGA Palette
Bypass VGA Palette to Enable use of 16 Grays causes Grayscale images to be displayed with 

16 grays and makes the Display thumbnails in Grayscale option (in the New Album dialog box) available
Compatibility Test tests to see if your display card is compatible with this feature

Related topic
Display dialog box



Load Settings
File Name initially shows the CFG extension; if you know the path and name of the file you wish 

to load, enter it here or select it from the list box
List Files of Type shows the file extension for settings files (CFG)
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Browse accesses the Browse dialog box, use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)



Save Settings
File Name initially shows the CFG extension; enter the filename you wish to save to or select a 

filename from the list box
List Files of Type shows the file extension for settings files (CFG)
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Browse accesses the Browse dialog box, use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)



Expand
Canvas adds an area of specified width and color around an image
Border adds a line of specified width and color outside the canvas area
Shadow adds a shadow of specified width outside the border
Shadow Direction determines on which side of the image the shadow will appear
Canvas/Border/Shadow Color opens a dialog box that you can use to choose a color

Related topics
Expanding an image
Post Processing dialog box
Batch Manager dialog box



Resolution
Current Resolution shows the resolution of the active image
Display sets the resolution to be the same as your display
Printer sets the resolution to be the same as your currently selected printer (selected in the 

Printer Setup dialog box)
User Defined allows you to define your own resolution

Related topics
Changing the resolution
Post Processing dialog box
Batch Manager dialog box



Color Schemes
Color Scheme lists all the available color schemes



Set Color
Basic Colors allows you to select a color to replace the old one
Custom Colors lets you add your own color
Define Custom Colors displays the color palette from which you choose your own color to add 

to the custom colors

Note: If you have tried all the options to select colors, you may have noticed that when a dialog box 
appears, it is always the same. The only thing that differs is the title bar. Regardless of what color you 
want to change, whether foreground, background, or cell color (for Indexed-Color images), the basic 
method for selecting a color is the same.

Related topics
Expand dialog box
Color Table dialog box



Execution File
File Name shows the EXE extension or a selected filename; if you know the path and name of 

the execution file from which you wish to capture, enter it here
Description of an execution file shown in the Filename text box
Resource Type allows you to choose icon, bitmap, and pointer
Resources lists all the resources available in the execution file
Screen Colors allows you to choose a background color for the resource to be captured
Browse accesses the Browse dialog box, use this dialog box to search for files
View is used to display bitmaps that are too large to show at actual view in the preview box
Preview Box displays the resource selected in the Resources list box

Related topic
Capturing images



File
File Name initially shows the selected file extension, enter the filename you wish to save to or 

select a filename from the files list box to overwrite that file
List Files of Type lists the file formats and their extensions
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Options accesses the save options dialog boxes for file formats that provide options
Browse accesses the Browse dialog box, use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)
Save to Album allows you to choose whether or not to save a thumbnail of the file to Album
Album accesses the Insert Thumbnails into Album dialog box. Use this to place files into albums 

in Album's workspace or into a newly created album
Automatically Number allows you to save captured images to consecutively numbered files

Related topic
Capturing images



Activation
Hot Key allows you to choose a preset hot key or specify your own. If your Source setting is 

Selected Object or Selected Area, only the Hot Key option is available
Delay lets you specify the amount of time that elapses between pressing the hot key and 

capturing an image
Repeat allows you to capture images at a set interval and choose the number of images you 

want to capture

Note: You can also specify the hot key in the Ribbons Hot key list box.

Related topics
Capturing images
Screen Capture Ribbon



Post Processing
Expand Captured Image creates a border or shadow around the image
Convert Data Type changes the data type of the captured image
Change Resolution resizes the image without actually changing the number of pixels it contains

Note: The post-processing options are also available in Screen Captures Ribbon.

Related topics
Setting the Post Processing options
Screen Capture Ribbon



Hot Key
Current Hot Key shows the present hot key
New Hot Key displays the new combination of keys you choose

Related topic
Activation dialog box



Select Pointer
Windows Pointer allows you to select one of the pointers used by Windows
Program Pointer allows you to select a pointer from a specified execution file
File Name defines the name of the execution file from which you want to select a pointer (use the

Browse button to locate a file)
Pointers shows all the pointers provided by Windows or available in the selected execution file
Browse accesses the Browse dialog box, use this dialog box to search for execution files

Related topic
Choosing the pointer to capture



Color Table
Color squares click on a color square to change its color
Load loads a previously saved color table into the active image
Save saves the active image's color table for use in another indexed image



Load Color Table
File Name initially shows the PAL extension; if you know the path and name of the color table you

wish to load, enter it here or select it from the list box
List Files of Type shows the file extension for color tables (PAL)
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Browse accesses the Browse dialog box, use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topic
Color Table dialog box



Save Color Table
File Name initially shows the PAL extension; enter a filename you wish to save to or select a 

filename from the files list box to overwrite that file
List Files of Type lists the PAL extension for color tables
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Browse accesses the Browse dialog box, use this dialog box to search files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topic
Color Table dialog box



Convert from Black & White
Cell Size defines the size of the cell used to convert the black and white pixels of a Black & White

image to shades of gray
Scale Down defines how much the image will be scaled down

Related topic
Converting images



Convert to Black & White

Resolution:
Display defines the resolution of the new image to be the same as that of the active image
Active Image defines the resolution of the new image to be the same as that of the active image
Printer defines the resolution as that of the printer selected in the Printer Setup dialog box
User Defined allows you to enter your own value as the resolution

Halftone screen:
Shape allows you to choose dithering options or a halftone screen shape
Frequency determines the size of halftone dots (of the shape selected)
Angle allows you to set the angle of the halftone screen

Related topic
Converting images



Convert to Indexed 16-Color (from Grayscale)

Dither:
None does not dither the image
Pattern arranges pixels in patterns to simulate the grays that are not in the color table
Diffusion uses a less structured method to dither grays not found in the color table

Related topic
Converting images



Convert to Indexed 16-Color (from other data types)

Palette:
Standard uses the system's default 16-Color table
Optimized creates a color table that is the closest adaptation of the colors used in the image

Dither:
None does not dither the image
Pattern arranges pixels in patterns to simulate the grays that are not in the color table
Diffusion uses a less structured method to dither grays not found in the color table

Related topic
Converting images



Convert to Indexed 256-Color

Palette:
3-3-2 (bits) uses the system's default 256-Color (8-bit) table
6-7-6 (levels) gives a palette which offers six shades of red, seven shades of green and six 

shades of blue
6-6-6 (levels) gives the most balanced use of the color palette
Optimized creates a color table that matches the range of colors used in the image as closely as 

possible

Dither:
None does not dither the image
Pattern arranges pixels in patterns to simulate the grays that are not in the color table
Diffusion uses a less structured method to dither grays not found in the color table

Related topic
Converting images



Configure
Element List contains information items that you can display in the status bar
Status Bar contains the information items currently displayed in the status bar
Add >> moves information items selected from the Elements list box into the Status Bar list box
<< Remove removes selected information items from the Status Bar list box, returning them to 

the Element list box
Remove All removes all information items from the Status Bar list box
Short Format when selected, abbreviates information items to appear in the status bar
Up and Down move a selected information item up or down in the Status Bar list box

Related topic
Configuring the Status Bar



Convert
Convert to allows you to select the data type to which all images will be converted to

Note: After pressing the OK button, Screen Capture will display the appropriate convert dialog boxes 
based on the data types of the selected images.

Related topic
Batch Manager dialog box
Converting images



Browse



cgm



dxf



pcd



pic



bmp



eps



iff



jpeg



psd



ras



tga



tif



 Using Screen Capture
Screen Capture basics
Editing images
Capturing images
Converting images
Configuring the Status Bar



Screen Capture basics
Using the Batch Manager
Opening an image
Finding files
Saving an image
Printing an image
Closing an image
Calibrating your display
Getting information
Exiting Screen Capture



Editing images
Expanding an image
Changing the resolution
Cropping the edges



Capturing images
Capturing an image
Capturing a selected area
Setting the post processing options
Choosing the pointer to capture
Using delayed activation



Calibrating your display

Calibrate your display before you start working with images for the first time. Recalibrate whenever you 
change your monitor, display adapter, or the environment in which you work.

The lighting of your work area and the brightness and contrast settings of your monitor all affect the way
images are displayed. Try to keep these variables as constant as possible to ensure that images display
consistently and accurately.

1. Choose "Preferences: Display" from the File menu. The Display dialog box appears.
2. Make sure the Monitor gamma check box is unchecked.
3. Click OK to close the dialog box.
4. Choose "Open" from the File menu. The Open dialog box appears.
5. Open the file IPGAMMA.TIF. You should be able to find this file in your Pals2 directory or on the 

installation disks. The IPGAMMA.TIF image appears.
6. Look at this image and identify the gray square that best matches the vertical, gray background 

band. Make a note of the number displayed next to this square. If for example, the square at the 
bottom of the middle row looks most like the background, take a note of the number 1.7.
This number can be any value from 0.01 to 7.99. If none of the squares exactly match, you should 
estimate the best match.

7. Choose "Preferences:Display" from the File menu. The Display dialog box appears.
8. Click on the Monitor gamma check box and, in the text box, type the number you noted in step 6. 

Click OK and the Display dialog box closes.

Related topic
Display dialog box



Getting information

When working with images, you can easily get information about:

Images; choose "Image Information" from the View menu.
Your system; choose "System Information" from the View menu.



Opening an image

Use the Open command from the File menu to open image files from your hard disk, floppy drive, or 
network drive.

1. Choose "Open" to display the Open dialog box.
2. Select the appropriate file extension from the List Files of Type list box.
3. Locate the directory containing the image file in the Directories list box.
4. Click on the appropriate image file name in the Files list box.
5. Click on the Preview button to preview the image before opening.
6. Click OK and the image appears in a new window in your workspace.

Related topics
Open dialog box
Supported File Formats



Finding files

There is a Browse button in most dialog boxes which involve opening or accessing files on disk. Use 
this button to search for files:

1. Click on the Browse button to display the Browse dialog box.
2. Use the Directories list box to access the drive and directory you want to browse.
3. Click on the Scan button. The path you have specified is searched for files with a name matching 

that in the File Name text box. Matching files are then listed in the files found list box.
4. Select the file you want to open from the files found list box by clicking on it.
5. Click OK to return to the original dialog box. The file name and path you found appear in the File 

Name text box.

Related topic
Browse dialog box



Saving an image

Use the Save As command from the File menu to save a file for the first time. When saving you can 
choose the file format to save your image in and, if a compression option is available, whether or not to 
compress it.

1. Choose "Save As" to display the Save As dialog box.
2. From the Directories and Drives list boxes, choose the drive and directory to which you want to save 

the active image.
3. Select a format from the List Files of Type list box.
4. In the File Name text box type the name of your file (up to eight characters). You do not need to 

enter the file extension.
5. Click OK to return to the window containing your saved image.

Related topics
Save As dialog box
Supported File Formats



Printing an image

Use the Print command from the File menu to print images to any Windows-compatible output device. 
Select your printer with the Printer Setup command.

1. Choose "Print" to display the Print dialog box.
2. Decide how many copies you want to print and enter the number in the Copies text box.
3. Decide where you want the image to print on the page by making the necessary entries or clicking 

on the available options.
4. Click OK to print the image.

Related topic
Print dialog box



Closing an image

You can close the active image window by:

double-clicking on the window's control menu box.
clicking on the window's control menu box and choosing "Close".
choosing the Close command from the File menu.
if the image is minimized, clicking once on the icon and selecting the Close command from the 

menu which appears.
displaying the Batch Manager dialog box, selecting the name of the images to close and choosing

the Close or Close Quickly operation.

When you close modified or unsaved images, a message appears to confirm if you wish to save the 
changes to a disk file. Click on Yes to save the changes, No to disregard them.

Related topic
Batch Manager dialog box



Using the Batch Manager

Use the Batch Manager command from the File menu to apply a command to multiple images in a 
single operation. The commands available through the Batch Manager are: Close, Close Quickly, 
Convert, Expand, Minimize, Print, Resolution, Restore Window, Save, and Save to Album.

Simply select an operation, select some images, and then press OK. Screen Capture does the rest for 
you.

Related topic
Batch Manager dialog box



Exiting Screen Capture

Use the Exit command from the File menu to exit Screen Capture. You can also exit by:

double-clicking on the application control menu box.
clicking on the application control menu box and choosing "Close".
if Screen Capture is minimized, clicking once on the icon and selecting the Close command from 

the menu which appears.



Expanding an image

Use the Expand command in the Edit menu to create a frame, border or shadow around an image.

1. Choose "Expand" to display the Expand dialog box.
2. The Canvas, Border and Shadow options allow you to specify the number of pixels to be used to 

create a frame, border or shadow. Drag the slider indicator along the bar to change the number of 
pixels.

3. Click on a slider indicator and the appropriate color button is available. Press the color button to 
define a color.

4. In the color dialog box, define a color and click OK. The selected color appears in the appropriate 
slider bar.

5. Choose the direction of the shadow. You can preview the image with the new settings on the right 
hand side.

6. If you are satisfied with the result, click OK. The dialog box closes and the settings are applied to the
active image.

When expanding Indexed-Color or Grayscale images, the selected color is replaced by the closest 
matching color in the color table or converted to an equivalent gray value.

Related topic
Expand dialog box



Changing the resolution

Use the Resolution command from the Edit menu to determine the physical size of an image.You may 
want to change the resolution of an image before you print it. You can resize an image without actually 
changing the number of pixels in the image.

1. Choose "Resolution" to display the Resolution dialog box.
2. Decide what resolution you want to use: Display, Printer, or User defined. If you choose User 

defined, enter a new resolution in the text box.
3. Click OK to change the resolution of the active image. There is no change in the appearance of the 

image in Screen Capture.

Related topic
Resolution dialog box



Cropping the edges

Use the Crop command from the Edit menu to trim the edges of a selection area. The edges cropped 
cannot be retrieved again unless you immediately undo the Crop command.

1. Define an area of the image you wish to retain by clicking and dragging the mouse across it.
2. Choose "Crop" to discard the areas outside the selection marquee. Only the area you have selected 

will be retained.



Capturing an image

To capture specific screen regions or images you need to setup the desired source, destination and hot 
key.

1. Choose "Source" in the Capture menu and select the source. You can capture images from the 
screen, clipboard or execution file.
Alternatively, just select a source from the drop-down list box in the ribbon.

2. In the same menu, choose "Destination" to send the captured images to a file, Screen Capture 
workspace, the clipboard, a printer or Image Editor's workspace.
Each destination is shown by a button in the ribbon. Press one or more to define the destination(s).

3. Choose the Activation command to define a hot key.
The hot keys can be directly selected from the drop-down list box in the ribbon.

4. Choose the Post processing command to define post processing options.
Each option is shown by a button in the ribbon. Press the appropriate button to change the settings.

5. Press the hot key you have selected to capture the image to the specified destination.

Related topics
Setting the post-processing options
Capturing a selected area
Activation dialog box
Post Processing dialog box



Capturing a selected area

Use "Selected Area" from the Capture menu to capture an area you define by clicking and dragging the 
mouse across it.

1. Choose "Selected Area" from the Source submenu in the Capture menu.
2. Press your hot key (or key combination). The pointer changes and the previously selected area 

(shown by a highlighted area) appears on your screen.
3. Click and drag the pointer over the image to define an area to be captured.

Note: The captured image will include the area defined by the highlighted area.
4. Release the mouse button and check that you have selected the correct area. If you want to 

deselect the selected area, press the right mouse button.
5. Press Enter or click the mouse within the highlighted area. The selected area is captured.

Note: To cancel the whole operation, press the Esc key.

Using the magnifier:
Move the magnifier window by dragging it: when the mouse pointer is on the magnifier window it 

changes to a hand which you can use to reposition the window.
Increase the size of the window with the Page Down key; reduce it with the Page Up key.
Increase the zoom level with the "+" number pad key; reduce it with the "-" number pad key.

Related topic
Capturing images



Choosing the pointer to capture

Use the Pointer: User Defined command in the Capture menu to choose a pointer from an execution 
file. The captured image will then contain the selected pointer.

1. Choose "Pointer: User Defined" to display the Select Pointer dialog box.
2. Select the Application Pointer option. Enter the path and file name of the execution file, in the File 

Name text box.
3. Click OK. The pointers available in the application appear in the Pointers list box.
4. Click on a pointer to select it.
5. Click OK. The dialog box closes and allows you to capture an image with the specified pointer.

Related topic
Select Pointer dialog box



Setting the Post Processing options

Using the combination of Post Processing options you can reduce any post-capture editing to a 
minimum. Once you have set these options, every time you capture images the selected options are 
applied. To set these options:

1. Choose "Post Processing" from the Capture menu to display the Post Processing dialog box.
2. In the dialog box, you have three options: Expand images, Convert data types and Change 

resolution.
The same options are also available in the ribbon shown by three post processing buttons.

3. Select the Expand option to automatically add a border or shadow to an image. Press the Define 
button to display the Expand dialog box in which you can change the value or color of the canvas, 
border or shadow.

4. In the Convert option, select "Grayscale" to capture the images in grayscale. Some data types 
provide you with options.

5. Choose the desired resolution to change the resolution of images.
6. Click OK. The dialog box closes and applies the above options every time you capture an image.

Related topics
Converting images
Post Processing dialog box
Expand dialog box
Resolution dialog box



Using delayed activation

The User Define dialog box seems like an impossible dialog box to capture: when it is open and you 
press a key, that key becomes the hot key. The answer, delayed activation:

1. Set the Source to "Active Window".
2. Set the Destination to "Workspace".
3. Choose "Activation" from the Capture menu. The Activation dialog box appears.
4. In the Delay text box, enter 15 (seconds) and click on OK. The dialog box closes.
5. Press the hot key.
6. Choose "User Define" from the Hot Key combo box in the ribbon. The User Define dialog box 

appears.

Fifteen seconds after pressing the hot key, the captured image of the dialog box appears in your 
workspace (you can then close the User Define dialog box to view the newly captured image). The data 
type and size of the captured image depends upon your display adapter and any Post Processing 
commands you have selected.



Converting images

Conversion commands are applied to the original image. Screen Capture provides powerful conversion 
capabilities and you can convert from any supported data type to any other. This is important for the 
Post Processing conversion command because images are captured in the data type determined by 
your screen and may then be converted to any other type.

Note: If a conversion command is not selected for post processing, Screen Capture will convert 
captured images to True Color.
Image Type Can Convert to :
---------------------------------------------------------
Black & White Grayscale 

Indexed 16-Color
Indexed 256-Color
RGB HiColor
RGB True Color

Grayscale Black & White
Indexed 16-Color
Indexed 256-color
RGB HiColor
RGB True Color

Indexed 16-color Black & White
Grayscale
Indexed 256-color
RGB HiColor
RGB True Color

Indexed 256-color Black & White
Grayscale
Indexed 16-color
RGB HiColor
RGB True Color

RGB HiColor Black & White
Grayscale
Indexed 16-color
Indexed 256-color
RGB True Color

RGB True Color Black & White
Grayscale
Indexed 16-color

Indexed 256-color
RGB HiColor

Related topics
Supported Image Data Types
Convert menu



Configuring the Status Bar

The status bar at the bottom of the Screen Capture workspace provides you with information as you 
work. To customize the information which appears in the status bar:

1. Click on the configuration button in the status bar. The Configure dialog box appears.
2. To add information into the status bar, click on an option in the Elements list box and click on the 

"Add >>" button.
3. To remove information from the status bar, click on an option in the Status Bar list box and click on 

the "<< Remove" button.
4. Click on Up or Down to change the order of the information in the status bar.
5. Click OK. The dialog box closes and updates the information in the status bar.

Related topics
Status Bar
Configure dialog box



Screen Capture Ribbon

The ribbon appears at the top of the workspace, directly below the menu bar. It displays some of the 
current Screen Capture settings and allows you to change them easily. Source and Hot Key options are 
displayed in drop-down list boxes while Destination and Post Processing options are displayed as 
buttons. To change a setting, simply choose an option from the list box or click on a button.

To hide the ribbon, double-click on it or choose the Hide Ribbon command in the View menu.

Note: If a conversion command is not selected for post processing, Screen Capture will convert 
captured images to True Color.



Status Bar

The Status Bar runs along the bottom of the Screen Capture workspace. Within this bar, Screen 
Capture provides information that will help you as you work. On the left of the status bar, there is a 
configuration button. Click on this button to access the Configure dialog box to choose the information 
items you want to display in the status bar. The information varies according to what you are doing but 
may include:

information items. These can include the current capture settings, pointer position, free memory, 
and description of the last captured image.

during lengthy operations, the progress of the operation.
simple explanations of selected menu items.

Note: Double-clicking on the status bar will open the Preferences: Screen Capture dialog box

Related topics
Configuring the Status Bar
Configure dialog box





Save
Updates the last saved version of the image.
When you select this command for an image that has not been previously saved, the Save As dialog 
box appears.

Related topic
Save As dialog box



 Printer Setup
Please see your Windows documentation or Windows On-line Help for more information about this 
command.



Recent Files List
Contains the filenames of the most recently opened images. Simply click on a name in the list to open 
the image.



Preferences: Screen Capture
Allows you to customize some of the features of Screen Capture.

Related topic
Screen Capture dialog box



Preferences: Photo CD
Allows you to set the options for an image in PCD format (developed by Kodak for its Photo CD 
products and supports Grayscale, Indexed 256-Color, and RGB True Color images).

Related topic
Photo CD dialog box



Preferences: Display
Allows you to customize the display settings.

Related topic
Display dialog box



Preferences: Memory
Allows you to allocate additional working space.

Related topic
Memory dialog box



Preferences: File Formats
Allows you to choose the file formats you want to use.

Related topic
File Formats dialog box



Settings: Load
Allows you to load an existing capture settings file.

Related topic
Load Settings dialog box



Settings: Save
Allows you to save the current capture settings to a specified file.

Related topic
Save Settings dialog box



Undo
Will only undo the most recent change. If you need to undo all your unsaved changes, reopen the 
image to return to the last saved version.



Cut
Deletes a selection area and transfers it onto the clipboard. The removed area is filled with the current 
background color.



Copy
Duplicates the whole image or a selection area onto the clipboard.



Clear
Replaces a selection area with the current background color.



Select All
Selects a whole image.



Select None
Deselects any selected areas.



Background Color
Allows you to choose a background color to fill any area you cut or clear.

Related topic
Set Color dialog box



Color Schemes
Allows you to change the current Windows color scheme.

Related topic
Color Schemes dialog box



Crop
Trims the edges of the selection to retain only the selected area.

Related topic
Cropping the edges from an image



Activation
Lets you define a hot key, specify delayed capturing, and/or multiple, consecutive capturing.

Related topics
Activation dialog box
Using delayed activation



Source: Active Window
Can be an application window, a dialog box or an icon. A highlighted title bar distinguishes the active 
window from other windows on the screen.



Source: Active Workspace
Refers to the window frame without the menu bar. If you capture a minimized window using this option, 
the icon is captured.



Source: Full Screen
Captures everything displayed on the screen.



Source: Clipboard
Captures an image from the clipboard.



Source: Menu Under Pointer
Captures a menu item and the commands it contains.
Crop When Menu Under Pointer in the Screen Capture dialog box, determines the actual contents of 
images when they are captured. If Crop When Menu Under Pointer is selected, the captured image only
contains the chosen menu and menu title, any other visible part of the menu bar is blank.

If there is no menu under the pointer, this option captures the window under the pointer or, if there is no 
window, the whole screen.



Source: Execution File
Captures icons, bitmaps, and pointers from any Windows program. This is not controlled by the hot key 
or activation options.

Related topic
Execution File dialog box



Source: Selected Object
Allows you to select the object you want to capture. Select this option and press the hot key, the "object"
currently under the pointer is highlighted. To capture it, just click within the highlighted area or press 
Enter. Objects can be windows, buttons, icons, or even the whole screen.



Destination: File
Allows you to capture an image and automatically save it to disk in a predefined file format.

Related topic
File dialog box



Destination: Workspace
Directs captured images to the Screen Capture workspace.



Destination: Clipboard
Places captured images onto the Windows clipboard.



Destination: Printer
Sends the captured image directly to the current printer.

Related topic
Print dialog box



Destination: Image Editor
Directs captured images to the Image Editor workspace.



Pointer: No Pointer
Does not capture a pointer with the captured image.



To Black & White
When you convert images to black and white, none of the original colors or gray shades can be shown 
or represented in the new image. To simulate them with only black and white pixels, you may choose to 
dither (halftone) the original color or gray values.

Related topic
Convert to Black & White dialog box



From Black & White
All conversions from Black & White are the same. Black & White images retain the least amount of 
information, so converting to any other data type makes more shades of gray available. To make use of 
these shades, Screen Capture can average areas (cells) of black and white pixels together to produce 
different gray shades. The larger the cell, the more gray shades the converted image contains.

Related topic
Convert from Black & White dialog box



Grayscale
You can convert from any data type to grayscale. All conversions are direct except from Black & White 
which opens the B & W to Grayscale dialog box. Black & White images retain the least amount of 
information, so converting to grayscale makes more shades of gray available. To make use of these 
shades, Screen Capture can average areas (cells) of black and white pixels together to produce 
different gray shades. The larger the cell, the more gray shades the converted image contains.

Related topic
Convert from Black & White dialog box



To RGB HiColor
This data type has been introduced in conjunction with the influx of 15- and 16-bit color (32,000 and 
64,000 color display adapters). Use this data type if you are capturing from a HiColor display or if 
thousands of colors are just enough. Save images in this data type as it occupies 33% less disk space 
than RGB True Color.

Related topic
Convert from Black & White dialog box



To RGB True Color
This data type contains 256 shades of red, green and blue. When you mix all of these together you find 
16.7 million possible colors. Hence the term True Color. This data type retains the most information and 
flexibility.

Related topic
Convert from Black & White dialog box



Grayscale to Indexed-16
When you convert from Grayscale to Indexed 16-Color, Screen Capture uses the 16 grays that most 
closely match the range of grays in the Grayscale image. The Dither options allow you to choose how 
Screen Capture converts the missing gray shades to the 16 available ones.
If your active image is Grayscale and you select the Indexed 16-Color command in the Convert menu, 
the Convert to Indexed 16-Color dialog box appears.

Related topic
Convert to Indexed-16 dialog box



Other data types to Indexed-16
Indexed 16-Color can only record 16 different colors. All other color data types are able to record more 
than this. So, when you convert to Indexed 16-Color, you must decide how the 16 colors are chosen 
and how they are arranged (dithered) to simulate the excess colors from the original.

Related topic
Convert to Indexed-16 dialog box



True Color to Indexed-256
When you convert to Indexed 256-Color, you are converting thousands or even millions of colors to 256.
To get the most effective result, you need to decide how the 256 colors are chosen and how they are 
arranged (dithered) to simulate the original colors.

Related topic
Convert to Indexed-256 dialog box



Actual View
Shows the active image with each image pixel displayed by one screen pixel. This is the normal (1x) 
view of an image; when you open images they are displayed at this view.



Zoom In
Magnifies the view of the active image. Zoom in to work on small details in an image. You can zoom in 
from 2x to 8x.



Zoom Out
Reduces the view of the active image. Zoom out to view large images and compare several images. 
You can zoom out from 1/2x to 1/8x.



Fit in Window
Displays the whole of the active image to fit in a window. All the unavailable options are grayed out.



Image Information
Displays a dialog box containing information about the active image.



System Information
Displays a dialog box containing information about Windows, disk space, and the current display 
settings.



Hide/Show Ribbon
Hides or shows the ribbon below the menu bar.

Related topic
Using the Screen Capture Ribbon



Hide/Show Status Bar
Hides or shows the status bar at the bottom of the Screen Capture window.

Related topic
Configuring the status bar



Color Table
Displays the color look-up table for indexed-color images.

Related topic
Color Table dialog box



Cascade
Stacks open windows so that the title bars are visible.



Tile
Resizes all open windows to the same size and arranges them to fill the workspace.



Arrange Icons
Arranges all minimized icons along the bottom of the workspace.



Windows List
Contains the titles of all windows currently in the workspace.



Contents
Starts Help and displays the topics in the Screen Capture Help.



Glossary
Definitions of terms used by ImagePals programs and documentation.



Index
A complete listing of topics covered in Screen Capture help.



Tips & Techniques
Advice on how you can use Screen Capture more efficiently.



Technical Support
How to contact Ulead Systems when you have questions.



Search for Help on
Opens the Search dialog box containing keywords from the Help topics.



How to Use Help
Accesses the Windows guide to using Microsoft Help.



About Screen Capture
Displays the Screen Capture product information box.



About Ulead Products
Displays information about other products from Ulead System.



Hot Key
Allows you to choose a hot key. The hot key is the key, or combination of keys, you use to capture 
images from the screen or clipboard.
Four predefined hot keys are available. Choose "User Defined" to open the Hot Key dialog box where 
you can define your own hot key. You can also choose the hot key in the Activation dialog box from the 
Capture menu. 

Related topic
Hot Key dialog box



Expand
Sets or disables the post processing option to expand images as they are captured. Once this post 
processing option is set, it is applied to every image you capture. The same option can also be set in 
the Post Processing dialog box from the Capture menu.
To define the options, press the Expand button. In the dialog box that appears set the canvas, border 
and shadow values or colors and specify the shadow direction. You can preview the settings on the 
right hand side of the dialog box.

Related topics
Expand dialog box
Setting the Post Processing options



Convert
Sets or disables the post processing option to convert data types of images as they are captured. Once 
the post processing option is set, it is applied to every image you capture. The same option can also be 
set in the Post Processing dialog box from the Capture menu.
To define the option, press the Convert button to display the Convert menu. Choose a data type by 
clicking on it (a check mark appears before it). A dialog box appears if there are options available for 
that data type. Set the options in the dialog box and click OK.

Note: If a conversion command is not selected for post processing, Screen Capture will convert 
captured images to True Color.

Related topic
Converting images



Resolution
Sets or disables the post processing option to change the resolution of images as they are captured. 
Once the Resolution option is set, it is applied to every image you capture. The same option can also be
set in the Post Processing dialog box from the Capture menu.
If disabled, press the Resolution button to select it. The Resolution dialog box appears. Set the new 
resolution to be the same as the display, the printer or define your own resolution.

Related topics
Resolution dialog box
Setting the Post Processing options



This list box contains the available Windows color schemes. These include the resident schemes 
provided by Microsoft (Windows default, Arizona, Monochrome, Rugby, etc.) and any new ones you 
have created and saved with the Control Panel: Color Option. We recommend the Monochrome color 
scheme if you are capturing images for use in black-and-white publications. To define a custom color 
scheme, or redefine the color of an element in an existing scheme, you still have to use the Control 
Panel: Color option. However, once a color scheme is defined, you can choose it from within Screen 
Capture.



When this option is selected, the last characters of the file name (not extension) must be numerals.



Filenames can be entered with or without a file extension. If no extension is entered, the extension 
selected in the List Files of Type list box is automatically added.



Filenames can be entered with or without a file extension. If no extension is entered, the PAL extension 
is automatically added.



Within this list box, you can select multiple files by using the SHIFT and/or CTRL keys in conjunction 
with the mouse.



The following operations can be applied to several images at once: Close, Close Quickly, Convert, 
Expand, Minimize, Print, Resolution, Restore Window, Save, and Save to Album.
Close Quickly closes selected files without saving any changes. This command is unique to the Batch 
Manager.



If this option is selected, the captured image contains the chosen menu and its menu title while the rest 
of the menu bar is blank. If it is not selected, the adjacent menu titles may be completely or partially 
captured.

You should not select this option if you capture other objects with the Menu Under Pointer source 
selected.



This option retains in memory the status of an image immediately prior to a change made to it. After 
making a change, you may recover the previous state by selecting "Undo" from the Edit menu.

Disabling this option frees memory used by the Undo command. You may find performance is slightly 
faster but changes are irreversible.



When converting, the higher the number, the more shades of gray will be introduced and the smoother 
the transitions of tone in the image will be. For line-art images, use a cell size of one. For a photo 
scanned with a black and white hand-held scanner, choose a cell size from three to eight (depending on
the settings of the scanner). If the result of this command shows visible grids in the image, the cell size 
is not correct. Undo the conversion and try a different cell size.



A scale-down value of one results in no scaling. A scale-down value of two reduces the width in pixels, 
height in pixels, and resolution of the image by half.



If you have a high resolution printer selected, this will produce a very large (in memory), black and white
image, and the conversion may take a long time.



If you select a halftone screen shape you can then define the halftone frequency and angle.



The higher the value the smaller the dots.



This option uses the gray in the color table that is closest to the gray being converted. This tends to 
result in sharp transitions between shades of gray in the image.



Arranges pixels in patterns to simulate the grays that are not in the color table.



This option generally results in the most accurate conversion.



This color table contains the 16 Colors displayable on a CGA or EGA display device. This option is 
useful when you transfer images to other Windows applications, or when you need to ensure that the 
same color table is used for all images, e.g. as when creating images for an animation sequence to be 
generated in another application.



If your RGB True Color image only contains green and blue and you select the optimized option, the 
resulting color table will be made up primarily of the colors that appear in the image (that is, green and 
blue). Because the colors in most images are concentrated in particular areas of the color spectrum, the
Optimized option normally gives the best conversion.



The color in the table that is closest to the color under analysis is used. This tends to result in sharp 
transitions between shades of color in the image.



Arranges pixels in patterns to simulate colors not contained in the color table.



This option uses a less structured method to dither colors than the Pattern option. Diffusion generally 
results in the most accurate conversion.



This color table is based on an arrangement of eight (3-bit) reds, eight (3-bit) greens, and four (2-bit) 
blues.



This is the standard palette used by ZSoft Paintbrush IV Plus.



This palette offers six levels (shades) of red, six levels of green, and six levels of blue. This is the 
standard palette used by the Apple Macintosh computer.



If your RGB True Color image contains green and blue and you select the Optimized option, the 
resulting color table is made up primarily of colors that appear in the image (green and blue). Since 
colors in most images are concentrated in particular areas of the color spectrum, this option normally 
provides the most accurate conversion.



The item at the top of the Status Bar list box is displayed first on the left of the status bar with the other 
items following.



The information items are Source, Destination, Hot Key, Pointer, Firing, Last Capture, Pointer Position 
and Free Memory.



To define your own hot key, use the F1 - F12 key alone; CTRL or CTRL + SHIFT with any of the 
following keys: F1 - F12, 0 - 9, A - Z.



Before you select this option you should test your display card to see if it is compatible with the 
Compatibility test provided.



When you press this button, the color squares on the right become squares of different grays, if your 
card is compatible. If your card is incompatible, nothing will happen or you will have to restart your 
computer.



This option is available if you are using a 256-Color display. This is an important option if you want to 
view Grayscale images at the same time as color images on a 256-Color display, or compare any sort 
of image on a 256-Color display.



This affects the speed of display updating on 256-Color displays. When selected, Screen Capture only 
updates the active image. Images in the background may appear distorted, blurred or grayed. The 
content of the background images are not changed, only the way they are displayed. If you wish to 
compare two or more images, deselect this option.



Use this feature to display images correctly on all types of computer display. When this option is 
disabled, or set to 1.00, the display of images is not adjusted.



Source
Allows you to specify the screen regions or other places from which you can capture images. Choosing 
the right source is important as this will save you any unnecessary editing later on.
The screen regions you can capture from are Active Window, Active Workspace, Full Screen, Menu 
Under Pointer, Selected Object and Selected Area. You can also capture from the clipboard and 
execution files.
For more information on each source, refer to the Source submenu in the Capture Menu.
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Ulead ADK
 What is the ADK? 
 What can you do with the ADK? 
 What does the ADK contain  ?   
 Ordering Informatio  n   

Technical Support



What is the ADK?

The Ulead ADK is a set of sample programs with accompanying documentation. The 
documentation shows the application programming interface (API) calls supplied by Album 
and other Ulead programs. Other applications can call these APIs for access to Ulead 
program features such as reading and writing image data file. 

The ADK also shows sample programs for writing File Input/Output (FIO) and Media 
Input/Output (MIO) filters so Ulead products can access or catalog foreign file formats.

Related topics
What can you do with the ADK?
What does the ADK contain?
Ordering Information
Technical Support



What can you do with the ADK?

With ADK you can do the following:
Find existing IAC (Inter Application Compatible protocol) compatible programs to take 

advantage of existing MIO or FIO filters
Allow users to drag and drop files from your application into Album as thumbnails, 

and vice versa
Register your application as an IAC compatible program: you can insert thumbnails 

into albums when saving files and your application will be shown along with other Ulead 
products in the Switch menu. 

Create albums or insert thumbnails to albums for cataloging and browsing purposes.
Access a file format using existing FIO filters
Do file conversion using existing FIO filters.
Create new FIO filters for reading and writing specific multimedia file formats
Create new MIO filters for generating thumbnails and for cataloging specific 

multimedia file formats

Related topics
What is the ADK?
What does the ADK contain?
Ordering Information
Technical Support



What does the ADK contain?

The ADK consists of the following items:
Ulead ADK introduction
Ulead ADK document
Sample program diskette
License Notice and Distribution Agreement
Development Support Option
Suggestion Form
Order Form

Related topics
What is the ADK?
What can you do with the ADK?
Ordering Information
Technical Support



Ordering Information

This list shows the ADK packages and their per unit prices. All prices are in US dollars and 
subject to change without notice.

Base Produc  t:      $ 600
Base Product with Development suppor  t:      $ 2,100
Development Suppor  t:      $ 1,500
Shipping and Handling (Asia):    $ 35
Shipping and Handling (Worldwide):    $ 50
North and South American orders
International orders

Related topics
What is the ADK?
What can you do with the ADK?
What does the ADK contain?
Technical Support



Technical Support

If you have any questions or comments about this or any other Ulead products, we want to 
hear from you. Ulead has three offices to help you:
Before you call, please prepare the following information so we can offer you the best 
possible support:

The program name and serial number
Nature of the problem
Any error messages or dialog boxes that appear when the problem occurs
System information including the type CPU, your operating system, and any other 

programs running at the time the problem occurs.
If you decide to write or fax us, add printouts of the following:

AUTOEXEC.BAT
CONFIG.SYS
WIN.INI
ULEAD.INI

Note: You can obtain copies of these files quickly by running SYSEDIT.EXE in your Windows 
program directory.

In North and South America
Europe
International 



In North and South America

Our California offices are open Monday through Friday from 9:00 AM to 5:00 PM Pacific 
Standard Time.

Phone us at 
(310)-523-9393

Fax us at 
(310)-523-9399

Write to us at
Ulead Systems, Inc.
970 West 190th Street, Suite 520
Torrance, CA 90502

Call the Ulead BBS at
(310)-523-9389 19200 bps (N,8,1)

Or send EMail to
(MCI Link gateway on Internet)

ULead@mcimail.com 
(MCI Mail)

EMS: ULead / MCI ID: 522-0621
MBX: Support @ ultc 

(Compuserve)
101400,221 

(Internet)
ulead@c2.hinet.net 

-or-
idpt871@tpts1.seed.net.tw



International

Our international headquarters in Taiwan, R.O.C. has personnel fluent in English, French, 
German, and Chinese available to help. Office hours are Monday through Friday from 9:00 
AM to 6:30 PM Taiwan time.

Phone us at 
+886 (2) 764-8599

Fax us at 
+886 (2) 764-9599

Write to us at
Ulead Systems, Inc.
12F-A, 563 Chung Hsiao E. Rd.,
Sec 4,
Taipei, Taiwan, R.O.C.

Call the Ulead BBS at
+886-2-764-7585 19200 bps (N,8,1)

Or send EMail to
(MCI Link gateway on Internet)

ULead@mcimail.com 
(MCI Mail)

EMS: ULead / MCI ID: 522-0621
MBX: Support @ ultc 

(Compuserve)
101400,221 

(Internet)
ulead@c2.hinet.net 

-or-
idpt871@tpts1.seed.net.tw



Europe

Our Customer SupportCenter in Germany is open Monday through Friday from 8:00 AM to 
5:00 PM GMT.

Phone us at 
+49 6042-68472

Fax us at 
+49 6042-68575

Write to us at
Ulead Customer Support.
An der Saline 31
D-63654 Büdingen, BRD

Call the Ulead BBS at
+886-2-764-7585 19200 bps (N,8,1)

Or send EMail to
(MCI Link gateway on Internet)

ULead@mcimail.com 
(MCI Mail)

EMS: ULead / MCI ID: 522-0621
MBX: Support @ ultc 

(Compuserve)
101400,221 

(Internet)
ulead@c2.hinet.net 

-or-
idpt871@tpts1.seed.net.tw



The base product contains the ADK and access to public bulletins and messages on the 
Ulead BBS.



The base product with development support contains the ADK an complete technical support
via fax, EMail, or BBS for sixty (60) days or twenty (20) hours, whichever comes first.



Development support offers extended technical support to those who already own the ADK 
via fax, E-Mail, or BBS. Each contract covers sixty (60) days or twenty (20) hours, whichever 
comes first.



Screen Capture tips & techniques
You can set your Windows color scheme directly from Screen Capture using the Color 

Schemes command in the Edit menu.
When capturing screens for grayscale or black and white printing, use monochrome 

as your default color scheme.
For general capturing purposes, leave the capture target as Menu Under Pointer. This 

captures whatever your mouse is currently resting on.
When capturing menus, remember to place your mouse over the command you want 

to be highlighted.
It is a good idea to save your capture settings using the Settings command in the File

menu, particularly if you are capturing at different resolutions, color schemes and data 
types.

If capturing a lot of images, use the File option as your destination.
Set a one pixel border in the Expand dialog box if you want a border for a full screen 

captured image.




